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Executive Summary 

What is photogrammetry? 

Photogrammetry is a method of creating a three-dimensional (3D) model of an object(s) using 
two-dimensional images. Using software, such as Agisoft Metashape, these images are aligned 
in such a way that commonalities between the photos are identified and tied together. This 
allows the software to create meshes and textures for the model so that an accurate product of 
the object(s) can be made. 

How is it collected? 

There are a variety of ways to collect images for a photogrammetric model, to include cameras, 
drone footage, or ROV footage. To do this, a pre-planned route or flight path is established that 
will encircle the object(s) to provide as many different camera angles as possible, ensuring that 
the images overlap. This will allow for the most accurate model during post-processing. Once a 
series of images are taken of the desired object(s), the images or footage will be processed 
using photogrammetry software. 

Where can it be applied? 

Photogrammetry can be applied in a multitude of ways. In underwater archaeology, time on a 
site is limited. Creating a photogrammetric model of the site will allow archaeologists to further 
study the site and pose questions for future expeditions on that site. Photogrammetry is 
applicable for studying underwater geological features and comparing past and present models 
of the same geological feature to note changes. In marine biology, photogrammetry can be 
used to do comparative studies of coral species and to better understand benthic ecosystems 
of our oceans. 

Intended audience 
The intended audience of this document is NOAA Ocean Exploration staff and partners 
including marine archaeologists, remotely operated vehicle pilots, operations staff and 
expedition coordinators who seek to incorporate photogrammetric modeling as a cruise 
package deliverable. This paper will initially be shared internally with future plans to be 
submitted to the NOAA Central Library as a technical report after cross-divisional review. Note, 
the workflows presented focus on the industry-standard Agisoft Metashape photo modeling 
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software, and other softwares that may need NOAA IT approval before installation or 
incorporation onto a NOAA machine. 
 
Citation: Phipps, Raymond, Phil Hartmeyer, Frank Cantelas. 2023. Photogrammetry 
Recommendations. NOAA Tech. Memo. OAR OER; 006. NOAA Ocean Exploration. National 
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Definitions 
Term Definition 

Underwater Cultural 
Heritage (UCH) 

Per the UNESCO 2001 Convention, UCH is defined as all traces of 
human existence of a cultural, historical, or archaeological nature 
which have been partially or totally immersed, periodically or 
permanently, under the oceans and in lakes and rivers4. This is 
synonymous with the NOAA Ocean Exploration definition of maritime 
heritage. 

Agisoft Metashape Agisoft Metashape is a stand-alone software product that performs 
photogrammetric processing of digital images and generates 3D 
spatial data to be used in GIS applications, cultural heritage 
documentation, and visual effects production as well as for indirect 
measurements of objects of various scales.5 While the workflows in 
this document are specific to the Agisoft Metashape software 
package, they may inform other photogrammetric modeling software. 

Mesh When images are aligned, a point cloud is created that stores 
locations of the points. When creating a mesh, these points are 
converted into triangles, while still retaining the locations of the 
points, but are easier to work with. 

Photo-Model The product of the photogrammetric process, a three dimensional 
(3D) model of an object(s). 

Orthomosaic A photogrammetrically orthorectified set of images that have been 
aligned to create a seamless mosaic. 

Frames Per Second 
(FPS) 

Used to measure frame rate or the number of images consecutively 
displaced each second. This is important for picking out stills from 
footage. 

Graphics Processing 
Unit (GPU) 

An electronic circuit designed to accelerate computer graphics, and 
process multiple datasets simultaneously. 

                                                      
4 https://en.unesco.org/underwater-heritage/2001 
5 https://www.agisoft.com/ 



7 

Central Processing 
Unit (CPU) 

The control center of a computer, the main processor that runs the 
computer’s operating systems and applications. 

Chunk Chunk is a term used by Agisoft and is where photos are uploaded in 

 Agisoft Metashape. These can be renamed to reflect the model within 
the chunk. If sections of an object are being modeled in multiple 
chunks, they can be merged using the “merge chunk” function. 

Codec A program that compresses data to enable faster transmission and 
decompresses received data. For the purposes of this document, the 
data is video files. 

 
Related Documents 
NOAA Ocean Exploration ROV Manual Appendix D. Photogrammetry: Structure From Motion 
(in-press) 

ROV Data Acquisition 
The purpose of this section is to outline the best practices for ROV data acquisition for 
photogrammetry. The topics that are listed and described below will help optimize the creation 
of photo models from the gathered ROV data. 

Survey for Hazards 
Before collecting data for photogrammetry, a survey of the site should be conducted to identify 
any hazards that may impact the ROV in any way. If hazards are identified, be sure to adjust the 
pre-planned flight path accordingly. 

Turn Off Lasers 
The scale lasers can create unwanted red dots on the end product. Be sure to turn these off 
prior to starting the photogrammetric flight path. Prior to turning these off, attempt to take 
photos of distinctive sections of the UCH site with the lasers on. Try to have one of the lasers at 
the end of the object on the site and the other going lengthwise of it. If this could be done to at 
least 3 objects on the UCH site it would help in scaling the photo model during the 

https://docs.google.com/document/d/1AWiEBUeMdM912SPUFfgPXIFqaUPGfhw3yfVLeKyg77o/edit?usp=sharing
https://docs.google.com/document/d/1AWiEBUeMdM912SPUFfgPXIFqaUPGfhw3yfVLeKyg77o/edit?usp=sharing
https://docs.google.com/document/d/1AWiEBUeMdM912SPUFfgPXIFqaUPGfhw3yfVLeKyg77o/edit?usp=sharing
https://docs.google.com/document/d/1AWiEBUeMdM912SPUFfgPXIFqaUPGfhw3yfVLeKyg77o/edit?usp=sharing
https://docs.google.com/document/d/1AWiEBUeMdM912SPUFfgPXIFqaUPGfhw3yfVLeKyg77o/edit?usp=sharing
https://docs.google.com/document/d/1AWiEBUeMdM912SPUFfgPXIFqaUPGfhw3yfVLeKyg77o/edit?usp=sharing
https://docs.google.com/document/d/1AWiEBUeMdM912SPUFfgPXIFqaUPGfhw3yfVLeKyg77o/edit?usp=sharing
https://docs.google.com/document/d/1AWiEBUeMdM912SPUFfgPXIFqaUPGfhw3yfVLeKyg77o/edit?usp=sharing
https://docs.google.com/document/d/1AWiEBUeMdM912SPUFfgPXIFqaUPGfhw3yfVLeKyg77o/edit?usp=sharing
https://docs.google.com/document/d/1AWiEBUeMdM912SPUFfgPXIFqaUPGfhw3yfVLeKyg77o/edit?usp=sharing
https://docs.google.com/document/d/1AWiEBUeMdM912SPUFfgPXIFqaUPGfhw3yfVLeKyg77o/edit?usp=sharing
https://docs.google.com/document/d/1AWiEBUeMdM912SPUFfgPXIFqaUPGfhw3yfVLeKyg77o/edit?usp=sharing
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post-processing phase. (NOTE: Be sure that the objects being measure are in the footage for 
the 
ROV flight path) 

Do Not Zoom 
During the photogrammetric flight path, avoid zooming as these segments can cause distortion 
and stretching in the final product. 

ROV Positioning During Data Acquisition 
Maintain elevation in the water column as much as possible, this will help maintain a consistent 
shot of the object(s) being documented and ensure that the proper amount of overlap during 
post-processing of the data. Be aware of possible vertical reliefs from UCH, geological, or coral 
sites. Pre-planning should cover these possibilities and provide a series of plans to navigate 
them. 

Ship Moves 
During ship moves, maintain ROV position as much as possible in order to continue along the 
pre-planned flight path. Avoid zooming and any camera moves while in this position. If the ROV 
needs to move, attempt to return to the previous location if possible. 

Navigation Waypoints 
The archaeology lead and the ROV pilot should coordinate on where to drop waypoints to mark 
features and to take diagnostic measurements (e.g., length and width of the wreck) 

Model Processing Workflow 
The following section outlines a step-by-step workflow for processing ROV footage of sites for 
photogrammetry. The workflow presented is based off of Kōtarō Yamafune’s Agisoft 
Metashape workflow6. It will take the user through setting up specific folders for ease of access 
during the process, to downloading the footage and making it usable for Agisoft Metashape. 
From there each step in processing a photo model will be described in detail. 

                                                      
6 Kōtarō Yamafune, University of South Carolina Photogrammetry Workshop, Columbia, South Carolina (25 May - 3 
April 2022. Yamafune is an expert in photogrammetry and the photography of terrestrial and underwater 
archaeological sites. The workflow that has been used for this document is based on his recommendations from 
this workshop. Courtesy of Alyssa Saldivar, an East Carolina University graduate student, who was able to attend 
the workshop and provide detailed notes on Yamafune’s workflow. 
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Data Management 
All data should be stored on the marine archaeology Synology NAS Drive :/A and connected to 
the processing machine via a CAT5 ethernet cable. Once the following steps are created, run 
Free File Sync (or other data synchronization software) to duplicate all created folders on 
Synology NAS Drive :/B. This is called ‘Mirror Synchronization’ in Free File Sync and a 
walkthrough is available here. This data management strategy allows the processor to routinely 
backup the working files on NAS Drive :/A throughout processing. Once a model is complete, 
the model folder will be copied onto the :/R drive through VPN or when the processor is local 
to the office. Everything in the finished products folder will be copied to the NOAA Ocean 
Exploration Photogrammetry Google Drive folder. 

● Create a folder and include the expedition number and site name. It should look like the 
following: “EX1234_Site_Name” 

 

● In this main site folder create 4 new sub-folders and name them the following: “Agisoft 
Model Project Files”, “Finished Products”, “Images”, and “ROV Footage”. 

 

○ The “Agisoft Model Project Files folder” is where the Agisoft model and project 
will be saved. 

■ The model and project should be saved as “EX1234_Site_Name” 

https://freefilesync.org/
https://freefilesync.org/
https://freefilesync.org/
https://freefilesync.org/tutorials.php
https://drive.google.com/drive/folders/1XWK3UqxxssMqbj1-7GXNbXSjezF01KUe?usp=drive_link
https://drive.google.com/drive/folders/1XWK3UqxxssMqbj1-7GXNbXSjezF01KUe?usp=drive_link
https://drive.google.com/drive/folders/1XWK3UqxxssMqbj1-7GXNbXSjezF01KUe?usp=drive_link
https://drive.google.com/drive/folders/1XWK3UqxxssMqbj1-7GXNbXSjezF01KUe?usp=drive_link
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○ All images, 3D printing files, PDFs, and final export products that will be used or 
shared should be housed in the “Finished Products” folder. Create four sub-
folders, titled “Animations,” “Images,” “Models,” and “Orthomosaics.” 

 

○ In the “Images'' folder create two sub-folders titled “Processed Images” and “Raw 
Images.” Processed images refers to any raw images that have been exported 
out of Photoshop or other image-editing software for color correction, edits, or 
manipulation in any way by the model processor. Raw images are the images 
directly pulled from the ROV footage. 

 

■ It may be necessary to create additional sub-folders under “Processed 
Images” and “Raw Images.” In some cases, ROV-collected imagery on a 
UCH site could be broken into multiple, disconnected sections.. The sub-
folders would need to be named accordingly, for example 
“EX####_Site_Name_Bow_Images” and 
“EX####_Site_Name_Stern_Images.” 
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○ In the “ROV Footage” folder create two sub-folders titled “Converted ROV 
Footage” and “Raw ROV Footage.” Upon initial download, the ROV footage will 
be moved from the local C:/Downloads folder to the “Raw ROV Footage” folder, 
and after conversion to an .mp4 file, those exported video files will be stored in 
the “Converted ROV Footage” folder. 

 

■ It may be necessary to create additional sub-folders under “Converted 
ROV Footage” and “Raw ROV Footage.” In some cases, ROV-collected 
imagery on an UCH site could be broken into multiple, disconnected 
sections. The sub-folders would need to be named accordingly, for 
example “EX####_Site_Name_Bow” and “EX####_Site_Name_Stern.” 

 
● Create a site sub-folder in the S&T Google 

Drive_Teams_SynergisticOceanExploration_MarineArchaeology_Photogrammetry_Mod 
els to copy all finished products from the :/A NAS drive 

https://drive.google.com/drive/folders/1XWK3UqxxssMqbj1-7GXNbXSjezF01KUe?usp=drive_link
https://drive.google.com/drive/folders/1XWK3UqxxssMqbj1-7GXNbXSjezF01KUe?usp=drive_link
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ROV Download and Image Processing 
Before beginning model post processing, it is helpful to watch the entire dive. Video from 
Okeanos Explorer dives can be found on the Ocean Network Canada's Sea Tube website7 and 
on the FTP site8 maintained by the Global Foundation for Ocean Exploration (GFOE). These sites 
are accessible with a Collaboration Tools Account9. Sea Tube video is best for reviewing an 
entire dive and offers the opportunity to listen to dialog between the ROV pilots and the 
science team to understand how video was collected for modeling. Sea Tube video is 
continuous coverage of the entire dive. 

After reviewing in Sea Tube, video for modeling should be downloaded from the GFOE FTP site 
where it is available in full resolution and compressed format in five minute segments. If high 
resolution video is not available from the GFOE FTP site, or the dive occurred before 2015 and 
cruise information is not present on the GFOE FTP site, email oer.video@noaa.gov with the 
cruise and dive number requested. If cruise or dive number is unknown contact the NOAA 
Ocean Exploration marine archaeologist. 

● Download ROV footage from https://exdata.tgfoe.org/OkeanosCruises/ ○ Identify the 
segments of ROV footage that are needed (NOTE: they are in 5-minute increments) for 
the model. 

○ The downloads will be a .tar file. From the download folder on the computer, cut 
and paste the .tar file to the “Raw ROV Footage” folder created for the project. 

● To use the ROV footage, it needs to be converted to a .mp4 file. To do this, VLC Media 
Player is the recommended application or an application equivalent to this. VLC Media 
Player is NOAA approved and can be installed on NOAA machines by calling NSDesk 

○ Open VLC and select “Media” -> “Convert/Save” 

                                                      
7 https://data.oceannetworks.ca/ExpeditionManagement 
8 https://exdata.tgfoe.org/OkeanosCruises/ 
9 For information on accessing these data and to request a Collaboration Tools account visit 
https://oceanexplorer.noaa.gov/okeanos/collaboration-tools/science_annotations/welcome.html 

https://exdata.tgfoe.org/OkeanosCruises/
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○ This will open a “File Selection” menu. The “+ Add…” can be selected to choose 
the ROV .tar files. When the folder opens, change the file type to “All Files” to 
view the .tar files. 

■ Once the desired file(s) are added, select the “Convert/Save” button at the 
lower right of the menu. 

■ The “Convert Menu” will open. Here make sure under settings that 
“Convert” is selected. There is no need to select “Display the output”, or 
“Deinterlace”. Under “Profile” select “Video – H.264 + MP3 (MP4)” 

■ For the “Destination File” select the “Converted ROV Footage” folder that 
was created for this project and press “Start.” 

■ A menu may pop up, click “Overwrite” and the conversion process will 
initiate. 

● The converted .mp4 file can now be loaded into Agisoft Metashape to render stills from 
the footage, but another option to do this is in Adobe Photoshop or another photo 
editing software like Adobe Bridge. This will allow for any color corrections that are 
needed. (NOTE: Color corrections are usually needed to remove unwanted color from 
underwater footage, typically caused by the water itself. For example, some footage 
might have a green, yellow, or even blue tint caused by the water. Color correction can 
be applied to an entire batch of photos using the same adjustments.) 

○ To do this in photoshop, open up the application and click on the “Window” tab 
and select “Action.” 
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○ The “Actions” palette will appear. Select the folder icon at the bottom right of the 
palette and name the new set folder “Batch Actions.” 

○ On the same palette, next to the folder icon is the “Create New Action” icon. 
Select that and name the new action “Pre-treat Images.” Be sure to change “Set” 
to “Batch Actions.” This action is now recording, as indicated by the red circle on 
the palette. Any editing within photoshop while this action is recording will be 
saved within the “Pre-treat Images” action. 
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○ To start, first load a single image from the “Raw Image” folder under the project 
folder. Once uploaded, go to the “Filter” tab and select “Camera Raw Filter…” 

 

○ The image will open in a new window with a color editing window on the right-
hand side. Here adjustments will be made and recorded to be used for the “Pre-
treat images” action. Under the “Basic” tab, set the following parameters: 
Highlights (-100), Shadows (+100), and Dehaze (+50). Everything else should 
remain the same. Adjusting these settings will provide the images with more 
defined edges of the site. 
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○ Once these adjustments have been made, go back to the action palette and stop 

recording. Exit out of the raw image filter and do not save. In the next step, the 
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action that was created will be implemented on the images in the “Raw Image” 
folder. To do this, select the “File” tab, hover over “Automate” and select 
“Batch” from that drop down menu. 

 

○ The “Batch” window will open. Under “Play” under “Set” select “Batch Actions" 
and for “Action” select “Pre-Treat Images.” 

■ For “Source” ensure that “Folder” is selected and choose the “Raw Image” 
folder for the project that is being worked on. 

■ There are four options to select below this. Only select “Suppress File 
Open Options Dialogs” and “Suppress Color Profile Warnings.” ■ Under 
“Destination” ensure that “Folder” is selected and choose the 
“Processed Image” folder for the project that is being worked on. 
■ From here select “Ok” and the images will be processed. 
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● To use Agisoft Metashape, the proper codec is needed 
○ K-Lite_Codec_Pack_1687_Basic needs to be downloaded. To do this simply search 

for the ‘K-Lite Codec Pack’ and download the basic codex. 
■ This codec is a collection of audio and video codecs for Microsoft Windows 

DirectShow that allows the user's operating system and its software to 
play audio and video formats generally not supported by the operating 
system itself. 
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■ Once downloaded, open Agisoft Metashape and select “File” -> “Import” -
> “Import Video” 

■ A pop-up will open and will prompt you to select the Frames Per Second. 
For regular footage (footage that is taken by hand, such as underwater 
footage taken by a diver) “15” is optimal, for drone footage “5” is 
optimal, and for ROV footage “3” is optimal. 

■ Finally, these extracted images need to be sent to the “Raw Image” folder 
created for this project. t too ○ For Photoshop do the following: 

■ First, open Photoshop. Once open, either drag the .mp4 file(s) over or 
open them using “File” -> “Open” 

■ Once .mp4 file(s) are uploaded, select the file and then under “File” select 
“Export” -> “Render 

■ Select the “Raw Image” folder for this project and select it for the images 
to be sent too. 

■ The “Render Video” menu will open. Here, select the “Extracted Images” 
folder just created where the photos will be sent. 



20 

 

■ For “Format” select “JPEG” and for document size select “1920 x 1080” 
■ “Frame rate” can be customized for ROV footage. Set the fps from 1-3, 

based on the speed of the footage. 
■ For the “Range” select “All Frames” (this can be customized if the 

beginning and ending frames desired are known). 
■ “Render Options” select “Interactive OpenGL” 
■ Once these are selected, click “Render” in the top right corner. The photos 

will be sent to the designated folder 
● The next step is to go through the individual photos from the ROV footage. Duplicate 

photos from the same section of the site, anything that shows the frame or parts of the 
ROV, and zoom segments. Delete these as they are not wanted for the models. If some 
of these images make it into Agisoft during the modeling process, they can be 
individually deleted in Agisoft later on. 

Creating a Project 
In this section, Agisoft Metashape will be opened and instructions on how to create a project 
will be given. 

● Open up Agisoft Metashap and under “File” select “New.” 



21 

 

● Once a new project is created, be sure to save it using “Save as.” Remember to name 
the project with the expedition number and the site name “EX1234_Site_Name.” Also, 
be sure to save frequently throughout this process. 

● With Agisoft Metashape open, on the left hand side of the screen there is a 
“Workspace.” Within this workspace are sections referred to as a “chunk.” This is where 
the user will be working primarily. The processed ROV images will be uploaded here and 
subsequently be used to create a photo model. There can be multiple chunks added to 
a project workspace and can be renamed to reflect what is in the chunk. To add a new 
chunk, right click on the workspace and select “Add Chunk.” 
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● If there are multiple chunks, be sure to set the one that is being used as the active one. 
To do this, right click on the chunk and select “Set Active.” 

 
Adding Photos and Alignment 
In this section, images will be uploaded to the Agisoft Metashape software to begin the 
alignment process. This will create a series of tie points that tie the forward and subsequent 
images together. Once completed, a point cloud will have been created. 

● First confirm that the Graphics Processing Unit (GPU) is being utilized in Preferences. 
The GPU is an electronic circuit designed to accelerate computer graphics, and process 
multiple datasets simultaneously. The CPU is the control center of a computer, the main 
processor that runs the computer’s operating systems and applications. Using a GPU is 
preferable as it greatly increases processing speed. To change to this do the following: ○ 
“Tools” -> “Preferences” -> “GPU” 
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● In Agisoft, under the tab “Workflow”, select “Add Photos”. Then select the photos that 
are to be used for the photogrammetric model. 

 

● First, to align photos, under “Workflow”, select the “Align photos” button. 
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○ Here the “Alignment” menu will open. 
○ Select “Generic Preselection” and nothing else. 

■ Generic preselection helps process faster. Use this if there is 80% coverage 
from the previous image and 60% coverage from the next photo overlap. 
Keeping this on is the best option if the overlap is less than the desired 
amount mentioned above. 

○ For “Accuracy”, selecting “High” is usually the best option (NOTE: The better the 
camera- the lower the accuracy. Remember to choose the accuracy setting 
carefully, too much information can clutter and ruin a model).10 

■ Highest: should only be used if frames are extracted from a video. In some 
cases this can still be too much information for the software to process 
as it attempts to gather 100% of the info in the images. 

                                                      
10 Kōtarō Yamafune. 2016. “Using Computer Vision Photogrammetry (Agisoft Photoscan) to Record and Analyze 
Underwater Shipwreck Sites.” PhD diss. Texas A&M University. Underwater photogrammetry can be done with any 
type of camera that can be operated at the desired depth. Professional cameras (DSLR, SLR, Mirrorless) tend to 
have larger sensor sizes and more precise exposure control settings over the photos being taken, hence the 
recommendation for DSLR or SLR cameras. 
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■ High: should be used with Digital Single-Lens Reflex (DSLR) cameras or 
Single-Lens Reflex (SLR) cameras. This setting will gather 1/4th of the 
information. 

■ Medium: should be used with higher end cameras such as Mirrorless 
Cameras. This setting will gather 1/16th of the information. 

○ Key point limit (feature point) 
■ Select the maximum number of points that Agisoft can detect. 40,000 is 

ideal 
○ Tie point limit 

■ Select the image connections. 4,000 is ideal 
○ Select “Exclude Stationary tie point” (only if there are a lot of dust or scratches) 

■ Use this for dust or scratches on camera images too. It excludes non-
moving points. 

■ Use this for drone or ROV footage when the ROV sleds and arms are in 
view. 

○ Selecting “Guided image matching” is recommended for high resolution images 
that have between 50 to 100 megapixels per image in order to create an 
excessive amount of tie points that could be missed by the standard point 
detector. 
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● Once the alignment is completed, check the images to see which are not aligned. 
Images not successfully aligned will show “NA” at the end of the file name: Right click 
those images and select “Align Selected Cameras.“ 

 

○ If that does not work, clicking “Reset Camera Alignment” in the same menu as 
above and then repeating the previous step can help. 

○ Once aligned, verify if the realigned cameras are in line with the model (NOTE: 
Remember that aligning 100% of the images in the chunk is not always needed. 
Check the cameras that are far away to look for the “double ground” effect or 
overlapped sections of the model). Once that is complete be sure to save the 
project. 

Aligning to a Grid 
In this section, the model will be moved to fit on a grid map with the grid being the 
bottom/seafloor. This will help with scaling the model and taking measurements for research. 

● Move the model so that it fits properly with the grid as the ground 
○ This can be done using the orthographic view (shortcut is “5” on keyboard) 
○ Use “1”, “3”, and “7” keys as shortcuts to get straight shots of each view 
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○ To access the grid, go to the tab “Model” and hover over “Show/Move Items” and 
select “Show Grid” 

○ Move the model using the “Move Object” tool on the toolbar. 

 

● Once this is complete be sure to save the project. 

Removing Distortion 
(READ THIS STEP IN ITS ENTIRETY BEFORE ATTEMPTING) 

For this step, less accurate tie points will be removed. This entails looking for the Root Mean 
Square (RMS) value of normalized reprojection error and maximum reprojection error. This can 
be done by right clicking the chunk and clicking “show info”. To create a more accurate model, 
the goal is to lower these numbers. 

● To do this, first delete all any points that are far away that do not add anything to the 
model and are not associated with the object being modeled. Typically these points will 
be outside of the box that contains the model. To delete these points, select the dotted 
rectangle on the tool-bar and select from the three options, “Rectangle Selection,” 
“Circle Selection,” or “Free-Form Selection.” Click and drag the selection tool over the 
areas to be deleted and hit the “delete” key. 
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● Next, select the “Model” tab and select “Gradual Selections.” 

 

● There are four options, “Reprojection Error,” “Reconstruction Error,” “Image Count,” 
and 

“Projection Accuracy.” Click these in order, going from the top to the bottom but ignore 
“Image Count.” 
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● Move the slide bar to select 10% of the points which can be seen at the bottom left of 
the screen. Once selected, delete these points. 

 

● From here select the tab “Tools” and click on “Optimize Cameras”. 
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● Click all cameras, there should be 10. Then select “Optimize”. 

 
● Repeat this process for “Reprojection Error,” “Reconstruction Uncertainty,” and 

“Projection Accuracy” under “Gradual Selection” twice, selecting the same option back-
to-back then moving on to the next. 

● Once this step is complete be sure to save the project file. 
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Creating a Mesh 
NOTE: Remember to skip Dense Cloud/Point Cloud as it has been outdated since 2018. It 
slows down the modeling process, and creates low quality meshes11. 

In this section, the point cloud that was created during the alignment process will be converted 
into a polygonal mesh. This mesh can then be trimmed to ensure that any unnecessary sections 
of the model are removed. 

● On the tab “Workflow”, select “Mesh” 

 

● On the “Mesh Menu”, under “General” set the settings to the following: 
○ “Source Data” -> “Depth Map” 
○ “Surface Type” -> “Arbitrary(3D)” 
○ “Quality” -> “Medium” 

■ For GoPro use “High”, for a higher quality camera use “Medium” (Lower 
Resolution cameras need to be set higher). 

■ Face Count -> High 
● The length stays the same no matter what is chosen. “0” is the highest number of mesh 

possible (infinite). 

                                                      
11 Kōtarō Yamafune, University of South Carolina Photogrammetry Workshop, Columbia, South Carolina (25 May - 3 
April 2022. 
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● Under Advance, set the settings to the following: 
■ “Interpolation” -> “Enabled” (This fills in small holes) 

● If the model has no holes (at all), select Extrapolated 
■ “Depth Filter” -> “Mild” 

● Having it set to “Mild” will prevent a depth cloud from being created of the sky with 
images of the sky or water with underwater images. 

■ Select “Calculate Vortex Color” ● 
Gives the model color 

 

● Once this step is complete be sure to save the project file. 

Giving the Model Texture 
● Before moving forward with texture, be sure to delete any 

unnecessary areas of the model using the “Free-Form Selection” 
tool. If this isn’t done, the software will texture 100% of what is 
there (to include any background i.e. seafloor, water, etc.) This 
can cause the model to be less textured and not as crisp. To 
delete unnecessary areas of the, select the dotted rectangle on 
the tool-bar and select from the three options, “Rectangle 
Selection,” “Circle Selection,” or “Free-Form Selection.” Click and 
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drag the selection tool over the areas to be deleted and hit the 
“delete” key. 
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● Select the tab “Workflow” and select “Texture”, the Texture 
menu will pop up. Select the following settings 

■ “Texture type” -> “Diffuse Map” (“Occlusion Map” is black and white) 
■ “Source Data” -> “Image” (For “Occlusion Map” -> “3D Model”) 

● Only use “Occlusion Map” if a Mesh is being run on “Medium” or 
“High”, otherwise the mesh will be a low quality black and white 
mesh. 

■ “Mapping Mode” -> “Generic” 
■ “Blending Mode” -> “Mosaic” Or -> “Average” if there are cracks or voids 

in the model. 
■ “Texture size Count” -> Dependent on the computer being used 

● 4096 -> Regular Computer 
● 8162 -> Gaming Computer 
● 16384 -> Amazing Computer (See “Hardware Requirements”) 
● Under Advanced set the following settings 
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■ This option is enabled on default since it helps to avoid salt-and-pepper 
effect in case of a complicated surface with numerous tiny parts shading 
other parts of the model. Only in case of very specific tasks might it be 
recommended to switch the function off.12 

■ Enable Ghosting Filter 
● In case the scene includes some thin structures or moving objects 

which failed to be reconstructed as part of the polygonal model, it 
can be useful to switch on this option to avoid ghosting effect on 
the resulting texture.13 

 

● Once this step is complete be sure to save the project file. The 
model has been created. 

Scaling the Model 
In this section, the model will be scaled based on a modeled scale bar or if there is a modeled 
object on the site and its measurements are known. It should be noted that this method of 
scaling is only available in Agisoft Metashape Professional Version. 

                                                      
12 https://www.agisoft.com/pdf/metashape_1_5_en.pdf 
13 https://www.agisoft.com/pdf/metashape_1_5_en.pdf 
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● Locate the modeled scale bar or object, and go to the “0” marker on the scale or the 
extent of the object. 

● Once located, right-click and select “Add Marker.” Do the same at the farthest extent of 
the scale bar or object. 

● Locate the “Reference Tab” at the bottom of the workspace and highlight the markers 
that were created. Right-click them and create a scale bar. 

● This scale bar will populate below. Here the space beneath “Distance” can be selected 
and the measurement can be imputed. 

● To apply this, select “Update Transform” at the top of the workspace. 
● Once this step is complete be sure to save the project file. 

Finished Products 
For each model that is processed, the final step in Agisoft Metashape is to export a 
standardized set of finished products. These products range from orthomosaic images of the 
model from different vantages, and animation of the model that includes fly over shots to 360 
degree shots of the site and/or artifacts. Additionally, these models can be exported as a 3D 
model to be used internally or shared with partners who use software with 3D capabilities (CAD 
programs, 
Blender, Maya, etc) or for 3D printing. Each of these finished products will be saved within the 
“Finished Products” folder under each project folder on the :/A drive within the NAS and 
subsequently duplicated onto the photogrammetry Google Drive under “Models Finished 
Products.” 

Orthomosaic Creation 
Here an orthomosaic of the model will be created where any geometric distortion will be 
corrected and the imagery will be color balanced to produce a seamless mosaic. It is important 
to note that to do this high quality photos are necessary. Agisoft fixes distortions based on the 
mesh, so it is extremely accurate once scaled. Orthomosaics are only available to Agisoft 
Metashape Professional Version users. This section should be updated when Professional 
Version is secured. 

● Under the “Workflow” tab, select “Orthomosaic.” 
○ In the window that opens, under “Projection” select “Geographic” and select 

“Coordinate system.” 
○ For “Planar” select the vantage point that is desired for the orthomosaic. 

https://drive.google.com/drive/folders/1_DKL-mRmm1ksgs-g-MEXNpcvYIz02fW-?usp=drive_link
https://drive.google.com/drive/folders/1_DKL-mRmm1ksgs-g-MEXNpcvYIz02fW-?usp=drive_link
https://drive.google.com/drive/folders/1_DKL-mRmm1ksgs-g-MEXNpcvYIz02fW-?usp=drive_link
https://drive.google.com/drive/folders/1_DKL-mRmm1ksgs-g-MEXNpcvYIz02fW-?usp=drive_link
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○ Leave “Refine Seamless” unchecked. If this setting is applied it has a chance to 
crash the computer. This setting creates a mosaic from the best of photos and 
takes a significant amount of time to process. 

○ Ensure that “Enable Hole Filling” is selected 
○ Select “Ghosting” if there are objects in the model that are unwanted, for 

example fish, crustaceans, divers, etc. If this is selected the processing time will 
increase exponentially. 

○ Once the appropriate settings are selected, click “Ok” and the mosaic will be 
created and can be found under the chunk that it was created from. 

● To export an orthomosaic, it must be done within the Agisoft Metashape Professional 
software. The reason for this is the orthomosaic was processed at the highest resolution 
possible and can be changed during this export process. If outside software is used to 
change resolution, the coordinates used for the orthomosaic will be unusable 

○ Under the “File” tab, highlight “Export” and select “Export Orthomosaic.” Ensure 
that the naming convention that has previously been used is applied here 
(EX1234_Sitename_Bow/Stern/Midships/Miscellaneous) and set the “Max 
Dimensions” to 2000. 

○ For “Total Size” select “Write World File.” This will save a TFW file which is the 
scaling and coordinate information. 

○ Leave “Write BigTIFF File” unchecked 
○ Once completed, select “Export” 

Animation Creation 
In this section, an explanation on how to create animations of the model will be outlined. 
Animations bring models to life and can be presentable as a video or converted into a GIF file 
using Adobe Express and embedded into Google Docs, Slides, Sheets and other Google Suite 
products and embedded into Adobe PDFs. 

● Ensure that you set the chunk that you wish to animate as the active chunk. This can be 
done by right-clicking the chunk and selecting “Set Active.” Once this is done select the 
“View” tab select “Animation.” This will bring up the “Animation” palette at the bottom 
left section of the screen underneath the chunks. 
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● There are two standard ways to create animations for a model: horizontal and vertical. 
These can be selected by selecting the “Create” button on the “Animation” palette. 

 
● The “Create Track” window will open with a drop down menu to select either 

“Horizontal” or “Vertical.” Choose one that is suitable. For the “Keyframe Count,” select 
a number between 30 and 40. This is how many frames per degree for the animation. 

 

● Once these are selected, an animation will be created underneath the chunk. On the 
“Animation” palette, there is a play button that can be used to view the animation. 
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● While horizontal and vertical animations are standard, a customizable animation can be 
created to highlight specific features on a model. This can be done using the “+” option 
on the “Animation” palette. Before this is selected, make sure that the model is 
orientated in a way that will make for the best flight path. Plan out the flight path 
before 
this process begins. The model will have to be moved before the “+” button is selected. 
It is recommended that the “1”, “4”, and “6” keys on the keyboard are used to make 
adjustments to the model. 
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● Once the various viewpoints of the model are captured using the “+” button, select the 
play button. See the Vernon Basin example below: 

 

● Once the animation is made, it can be adjusted using the “Animation Settings” function. 
○ For “Label” name the animation using the same naming convention for the project 

(EX1234_Site name_Animation). 
○ “Duration” relegates the speed of the animation. The higher the number the 
slower the animation goes. Do not go past ○ Keep “Field of View” at 30 
degrees. 
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○ Select “Smooth Camera Track” as it makes the model less jumpy during 
animation. 

○ Leave everything else as is and select “Ok.” 
● To export an animation, right-click it under the chunk and select “Capture Video.” 

 

● A documents folder will open, be sure to save this under “Finished Products” in an 
“Animation” folder for the respective project. The file will be saved as an AVI file using 
the same naming convention as the project (EX1234_Sitename_Animation). 

● The AVI file can be converted to a GIF file if desired. This can be done through the 
Adobe Express application or an online GIF converter if Adobe Express cannot be 
installed. 

○ To do this open Adobe Express and under “Try a Quick Action” select “Convert to 
GIF.” 

 
○ From here either drag or browse the computer for the AVI file that is to be 

converted to a GIF file. Once uploaded, the file can be downloaded as a small, 
medium, or large file. It is recommended to download as a large file. 
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○ The GIF file can now be used to share or embed the model. 

Image Creation 
In this section, an overview of how to capture images of created models will be detailed. 

● To take photos of the model, do the following: 
○ Under “Model” select “Show/Hide” anything not wanted in the photo. ○ 
Change the background if desired 

■ Under “Tools” highlight “Preferences” and select “Appearance.” 
○ Under the tab “View” select “Capture Model.” 

■ Choose the desired resolution and then select “Ok.” 
○ Save the captured images in the “Finished Product” folder under the project 

folder. 

Exporting Finished Models 
In this section, an overview will be given on how to export finished models from Agisoft 
Metashape as an .OBJ file, .XYZ file, and .3DS file. A .OBJ is an open format that has wide 
support and application to other 3D software. A .XYZ file is a multi-data file type that is used to 
extract coordinates from images and camera locations. A .3DS is a file used for models in 
Autodesk. 

● For .OBJ files or .3DS files select the “File” tab and highlight “Export” and then select 
“Export Model.” 

● A computer documents page will open prompting the selection of a folder to save the 
model. Select the “Finished Products” folder and save the model as either .OBJ file or 
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.3DS file under the “Model” folder. Be sure to name the .OBJ file or .3DS file using the 
same naming convention that has been used previously (EX1234_Site name_Model). 
Export both .OBJ and .3DS. With each created .OBJ file, a Material Library (MTL) file will 
be created. Ensure that this file is created and remains with its respective .OBJ file. This 
will ensure that the .OBJ file can be uploaded within other virtual 3D platforms. 

● For an .XYZ file, repeat the steps above, but instead of selecting “Export Model,” select 
“Export Point Cloud” above it. Here the point cloud can be saved as an .XYZ file and 
saved using the same naming convention that has been used previously (EX1234_Site 
name_XYZ). 

 

Photogrammetry Snapshots 
After exporting finished products out of Agisoft Metashape, a Photogrammetry Snapshot will 
be created in Google Docs. The Snapshot is a summary document of the site that has been 
modeled and includes an animation, images, and the Model Metadata discussed in the section 
below. It is designed to be shared within the office and externally with partners interested in 
the site. There may be public-facing uses that include hosting this document on relevant 
oceanexplorer.noaa.gov project pages, and within the cruise data package for the respective 
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dive where the ROV video was used to process the model. Please consult the USS Baltimore (C-
3) Photogrammetry Snapshot as an example. 

To begin, locate the Photogrammetry Snapshot Template in the Photogrammetry_Models 
Google Drive Folder. Open this in Google Docs and select “File_Make A Copy”. Name it using 
the established photogrammetry naming convention of cruisenumber_site: 
“EX1234_Site_Name”. 
Under the folder, have the new snapshot be saved under the respective site’s model folder. 
Example below: 

 

Once the Photogrammetry Snapshot is complete, download the file and save a .DOCX and .PDF 
to the Finished Products folder on the :/A NAS drive and backup :/A to :/B using Free File Sync. 
More information on model metadata required for every model is presented in the next 
section. 

Snap2HTML Creation 
In this section, a step by step guide to creating a Snap2HTML will be given. This tool is used to 
create an interactive snapshot of folder structures on a harddrive, and saves it as an HTML. This 
will allow a user to look at the HTML of a specific model and verify if all of the respective data 
(Models, Finished Products, Images, Footage) is stored on the NAS :/R drive. 

https://docs.google.com/document/d/1QLj2m7pb4BtAV3_TMz4Yp_b9hO5tX8y7GqehZJG5t8Q/edit?usp=drive_link
https://docs.google.com/document/d/1QLj2m7pb4BtAV3_TMz4Yp_b9hO5tX8y7GqehZJG5t8Q/edit?usp=drive_link
https://docs.google.com/document/d/1QLj2m7pb4BtAV3_TMz4Yp_b9hO5tX8y7GqehZJG5t8Q/edit?usp=drive_link
https://docs.google.com/document/d/1QLj2m7pb4BtAV3_TMz4Yp_b9hO5tX8y7GqehZJG5t8Q/edit?usp=drive_link
https://docs.google.com/document/d/1QLj2m7pb4BtAV3_TMz4Yp_b9hO5tX8y7GqehZJG5t8Q/edit?usp=drive_link
https://docs.google.com/document/d/1QLj2m7pb4BtAV3_TMz4Yp_b9hO5tX8y7GqehZJG5t8Q/edit?usp=drive_link
https://docs.google.com/document/d/19th8Akmbk-loIl_cXpOS9AwuGo8pu2PBf_KJ86_Ames/edit?usp=drive_link
https://docs.google.com/document/d/19th8Akmbk-loIl_cXpOS9AwuGo8pu2PBf_KJ86_Ames/edit?usp=drive_link
https://docs.google.com/document/d/19th8Akmbk-loIl_cXpOS9AwuGo8pu2PBf_KJ86_Ames/edit?usp=drive_link
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● To begin, download the “Snap2HTML” program from the following link: 
https://www.rlvision.com/snap2html/about.php 

 

● Once downloaded, the software and settings menu will open. From here select the 
folder group that is to be turned into an HTML. Once selected, click “Create Snapshot.” 
The snapshot can then be saved in the desired location and shared with other parties. 

https://www.rlvision.com/snap2html/about.php


47 

 

● Once completed, open the HTML link and the folder snapshot will look like the image 
below. Add the Snap2HTML file to the respective model Google Drive folder and link to 
it in the Photogrammetry Log. 

 

Model Metadata Information 
All models should have the following standardized metadata included logged in the NOAA 
Ocean Exploration Photogrammetry Log. These metadata should be included wherever models 
are publicly shared. 

UCH Site Summary 
The UCH site summary is a short historical summary and archaeological interpretation of the 
site managed by the NOAA Ocean Exploration marine archaeologist. The four sections below 
provide a list of essential information by category that need to be included in a UCH Site 
Summary. 

https://docs.google.com/spreadsheets/d/1yniE2D18QzVmPRDUDzboda_0EDHhS0JaXVgfw-QZgkY/edit?usp=sharing
https://docs.google.com/spreadsheets/d/1yniE2D18QzVmPRDUDzboda_0EDHhS0JaXVgfw-QZgkY/edit?usp=sharing
https://docs.google.com/spreadsheets/d/1yniE2D18QzVmPRDUDzboda_0EDHhS0JaXVgfw-QZgkY/edit?usp=sharing
https://docs.google.com/spreadsheets/d/1yniE2D18QzVmPRDUDzboda_0EDHhS0JaXVgfw-QZgkY/edit?usp=sharing
https://docs.google.com/spreadsheets/d/1yniE2D18QzVmPRDUDzboda_0EDHhS0JaXVgfw-QZgkY/edit?usp=sharing
https://docs.google.com/spreadsheets/d/1yniE2D18QzVmPRDUDzboda_0EDHhS0JaXVgfw-QZgkY/edit?usp=sharing
https://docs.google.com/spreadsheets/d/1yniE2D18QzVmPRDUDzboda_0EDHhS0JaXVgfw-QZgkY/edit?usp=sharing
https://docs.google.com/spreadsheets/d/1yniE2D18QzVmPRDUDzboda_0EDHhS0JaXVgfw-QZgkY/edit?usp=sharing
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Basic Information 

● Site name 
● Site Type (UCH/Geological/Coral/Others) 
● UCH Vessel Year Built 
● UCH Vessel Year Sank 
● Hull Material 
● Official Number 
● Cruise Number 
● ROV Dive Number 
● ROV Dive Date 
● Location ● Depth (meters) 

Dimensions 
● Site Length (Meters) 
● Site Width (Meters) 
● Site Height (Meters) 
● Site Orientation 
● Model Length (Meters) 
● Model Width (Meters) ● Model Height (Meters) 

Model Information 
● ROV used 
● Camera information 
● Video or Stills 
● Number of Images Used and Format 
● Image Alignment Percentage 
● Number of Tie Points 
● Link to raw images 
● Software Used and Version 
● Modeler/Affiliation 
● Time to complete 
● Model processor notes 
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Miscellaneous 
● Images of available (Bow, Stern, Plan View, Individual artifacts, Area of focus) 
● Available file format, location, and POC 
● Links to model 
● Link to NOAA Ocean Exploration project page 

Processed Models 
During the 2023 UCH Explorer-in-Training internship, Raymond Phipps generated 14 photo 
models from 8 UCH sites using this workflow and recommended hardware/software from past 
UCH dives: USS Baltimore (C-3), USS Muskallunge, Industry, the three piece Japanese mini-
submarine NO-16, Japanese mini-submarine NO-20 that was sunk by USS Ward, the Vernon 
Basin shipwreck, Site 15377, and USS S-19. Some ROV footage used to process these models 
was acquired with photogrammetry in mind, but most were not. These public-frendly 
Photogrammetry Snapshots are part of the final deliverable package for each model processed. 

Hardware and Software Recommendations 
The recommendation to use Agisoft Metashape for photogrammetry is because of the 
softwares ability to process images quickly, while at the same time providing accurate results 
from both aerial, underwater, and close-range photography. Agisoft Metashape has a 
multitude of uses that allow the user to process images from RGB or multispectral cameras, 
into dense point clouds, textured polygonal models, georeferenced true orthomosaics and 
DSMs/DTMs. Further post processing enables the texturing of artifacts from the models, 
calculating vegetation indices and automatically classifying dense point clouds, etc. 

Agisoft Metashape Pro Edition vs Standard Edition 

Features Professional 
Edition 

Standard 
Edition 

Core photogrammetry processing workflow   

 

Photogrammetric triangulation 

https://docs.google.com/document/d/1QLj2m7pb4BtAV3_TMz4Yp_b9hO5tX8y7GqehZJG5t8Q/edit?usp=sharing
https://docs.google.com/document/d/1QLj2m7pb4BtAV3_TMz4Yp_b9hO5tX8y7GqehZJG5t8Q/edit?usp=sharing
https://docs.google.com/document/d/1QLj2m7pb4BtAV3_TMz4Yp_b9hO5tX8y7GqehZJG5t8Q/edit?usp=sharing
https://docs.google.com/document/d/1HgWDLRalzX7SHxF371_OcWLcos0HHXhI5LoEETN2cVA/edit?usp=drive_link
https://docs.google.com/document/d/1HgWDLRalzX7SHxF371_OcWLcos0HHXhI5LoEETN2cVA/edit?usp=drive_link
https://docs.google.com/document/d/1cuhuKAyKihsJonB3dgR5VFwMH0Z_Yqc3seokc8OpBMY/edit?usp=drive_link
https://docs.google.com/document/d/11Zp1a6Z21zQFaKaoIF3kdCDGE6gsmuOEwI7Cy0NXBU0/edit?usp=drive_link
https://docs.google.com/document/d/11Zp1a6Z21zQFaKaoIF3kdCDGE6gsmuOEwI7Cy0NXBU0/edit?usp=drive_link
https://docs.google.com/document/d/11Zp1a6Z21zQFaKaoIF3kdCDGE6gsmuOEwI7Cy0NXBU0/edit?usp=drive_link
https://docs.google.com/document/d/11Zp1a6Z21zQFaKaoIF3kdCDGE6gsmuOEwI7Cy0NXBU0/edit?usp=drive_link
https://docs.google.com/document/d/11Zp1a6Z21zQFaKaoIF3kdCDGE6gsmuOEwI7Cy0NXBU0/edit?usp=drive_link
https://docs.google.com/document/d/11Zp1a6Z21zQFaKaoIF3kdCDGE6gsmuOEwI7Cy0NXBU0/edit?usp=drive_link
https://docs.google.com/document/d/11Zp1a6Z21zQFaKaoIF3kdCDGE6gsmuOEwI7Cy0NXBU0/edit?usp=drive_link
https://docs.google.com/document/d/1BCsrrkVepYXBMxjhW0bjFrly7-QIpDicyDgHeZqlKo0/edit?usp=drive_link
https://docs.google.com/document/d/1BCsrrkVepYXBMxjhW0bjFrly7-QIpDicyDgHeZqlKo0/edit?usp=drive_link
https://docs.google.com/document/d/1BCsrrkVepYXBMxjhW0bjFrly7-QIpDicyDgHeZqlKo0/edit?usp=drive_link
https://docs.google.com/document/d/1oyf298OiKBq76Tszed6xcQNm8pTKAMkqCEg5SW3UwaU/edit?usp=sharing
https://docs.google.com/document/d/1oyf298OiKBq76Tszed6xcQNm8pTKAMkqCEg5SW3UwaU/edit?usp=sharing
https://docs.google.com/document/d/1oyf298OiKBq76Tszed6xcQNm8pTKAMkqCEg5SW3UwaU/edit?usp=sharing
https://docs.google.com/document/d/1pfPjdSXQ94HOML8NJAwjm0dZaFlStIRcRJ3R9081ntM/edit?usp=sharing
https://docs.google.com/document/d/1pfPjdSXQ94HOML8NJAwjm0dZaFlStIRcRJ3R9081ntM/edit?usp=sharing
https://docs.google.com/document/u/0/d/1-K2Mqh4Wq-LhBneHt-NX4GR1E0XLuzP3m29uPqJQW6Q/edit
https://docs.google.com/document/u/0/d/1-K2Mqh4Wq-LhBneHt-NX4GR1E0XLuzP3m29uPqJQW6Q/edit


50 

Dense point cloud generation and editing 
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NDVI and other vegetation indices calculation 
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4D modeling for dynamic scenes 

https://www.agisoft.com/features/compare/


53 

GPU 1 - 2 NVIDIA or AMD GPUs with 1920 + 
unified shaders (Example: GeForce RTX 3080 
or Radeon RX 6800 XT) 

Source: https://www.agisoft.com/downloads/system-requirements/ 

Inhouse Photogrammetry Processing Purchase 
Recommendations 
The following recommendations price out costs to be able to process photogrammetry models 
in house for NOAA Ocean Exploration. Each item below has been added to the Synergistic 
Team’s FY24 budget request for S&T. 

Software 
Agisoft Metashape Professional - $3499 
This is a one-time license purchase that would be issued to NOAA Ocean Exploration for 
installation on one machine with no expiration date. It includes 12 months of technical support. 

Adobe Photoshop - $N/A 
Adobe Photoshop is required to color correct batches of images. We would need one license 
off the NOAA Ocean Exploration or NOAA Research Adobe contract. 

Storage 
Synology 20TB NAS Storage System - $1000 
Data management and storage is critical for photogrammetry model processing and requires a 
fast, stable solution. Using VPN or direct connection via CAT5 ethernet to access working files 
on the :/R drive severely affects processing speed and reliability. The :/R drive should be 
considered a final archive and backup for each completed model data package. The Synology 
Network Attached Storage (NAS) operates two Serial Advanced Technology Attachments 
(SATAs) that can transfer files up to 215 megabytes per second. The modeling software Agisoft 
is constantly writing and editing files where directed, and the NAS operating speed allows for 
efficient model creation, and sustainable file backup. The NAS will be utilized for other data 
heavy marine archaeology processing including GIS file storage and housed with the NOAA 
Ocean Exploration marine archaeologist. 

https://www.agisoft.com/downloads/system-requirements/
https://www.agisoft.com/buy/online-store/
https://www.agisoft.com/buy/online-store/
https://www.agisoft.com/buy/online-store/
https://www.bhphotovideo.com/c/product/1752526-REG/synology_20tb_diskstation_ds723_2_bay.html?smpm=ba_f2_ll&gclid=Cj0KCQjwzdOlBhCNARIsAPMwjbww9gtHH16F0icPf3_ncVKHQTmZZevc5C2KAJNTjG92QTmcmMhh12YaAryVEALw_wcB
https://www.bhphotovideo.com/c/product/1752526-REG/synology_20tb_diskstation_ds723_2_bay.html?smpm=ba_f2_ll&gclid=Cj0KCQjwzdOlBhCNARIsAPMwjbww9gtHH16F0icPf3_ncVKHQTmZZevc5C2KAJNTjG92QTmcmMhh12YaAryVEALw_wcB
https://www.bhphotovideo.com/c/product/1752526-REG/synology_20tb_diskstation_ds723_2_bay.html?smpm=ba_f2_ll&gclid=Cj0KCQjwzdOlBhCNARIsAPMwjbww9gtHH16F0icPf3_ncVKHQTmZZevc5C2KAJNTjG92QTmcmMhh12YaAryVEALw_wcB
https://www.bhphotovideo.com/c/product/1752526-REG/synology_20tb_diskstation_ds723_2_bay.html?smpm=ba_f2_ll&gclid=Cj0KCQjwzdOlBhCNARIsAPMwjbww9gtHH16F0icPf3_ncVKHQTmZZevc5C2KAJNTjG92QTmcmMhh12YaAryVEALw_wcB
https://www.bhphotovideo.com/c/product/1752526-REG/synology_20tb_diskstation_ds723_2_bay.html?smpm=ba_f2_ll&gclid=Cj0KCQjwzdOlBhCNARIsAPMwjbww9gtHH16F0icPf3_ncVKHQTmZZevc5C2KAJNTjG92QTmcmMhh12YaAryVEALw_wcB
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Computing 
Processing Laptop - $9000 
The Synergistic Team requested $9000 to support Phil Hartmeyer’s GIS, marine remote sensing 
data analysis and marine archaeology interpretation needs as lead for the marine archaeology 
portfolio. The $9000 was based on a similar computer purchase request by the Data Analysis 
and Synthesis Team and may be less. This machine can also be used to process photo-models 
using the Agisoft software. Laptop specifics should align with below: 

Raymond Phipps’s Desktop Computer Information 
Case : Origin PC 5000D Airflow 
Processors (CPU) : Intel Core i9-13900K 24-Cores 3.0GHz (5.8GHz TurboBoost) 
Motherboard : MSI PRO Z790-A WIFI DDR5 
Memory (RAM): 64GB CORSAIR VENGEANCE DDR5 (2x32GB) 5600MHz 
System Cooling : iCUE H100i ELITE CAPELLIX XT Liquid CPU Cooler 
System Fans : ORIGIN PC Standard Fan Kit 
Graphics Cards (GPU): NVIDIA 8GB GeForce RTX 3060 
Operating System : MS Windows 11 Home 
Operating System Drive : 1TB Samsung 970 EVO Plus NVMe M.2 
Power Supply : CORSAIR CS750 SERIES PLUS GOLD 

Next Steps 

Photogrammetry can be applied in a multitude of ways. In underwater archaeology, time on a 
site is limited. Creating a photogrammetric model of the site will allow archaeologists to further 
study the site and pose questions for future expeditions on that site. Photogrammetry is 
applicable for studying underwater geological features and comparing past and present models 
of the same geological feature to note changes. In marine biology, photogrammetry can be 
used to do comparative studies of coral species and to better understand benthic ecosystems 
of our oceans. Beyond securing the above hardware and software that will unlock Science and 
Technology Division’s ability to process 3D photo models, several other considerations should 
be made: 

SketchFab is a premiere public depository for photo models. It’s public friendly, public forward, 
and models hosted there could be embedded into future oceanexplorer.noaa.gov web pages 
with full 3D manipulation capability for users. Federal agencies are using SketchFab to share 
model data including Scott Sorset (Archaeologist, Bureau of Ocean Energy Management-BOEM) 
who has published photo models he stitched from previous NOAA Ocean Exploration UCH ROV 
dives at BOEM’s Virtual Underwater Museum and NOAA Thunder Bay National Marine 

https://www.boem.gov/environment/virtual-archaeology-museum
https://www.boem.gov/environment/virtual-archaeology-museum
https://www.boem.gov/environment/virtual-archaeology-museum
https://sketchfab.com/thunderbaynms
https://sketchfab.com/thunderbaynms
https://sketchfab.com/thunderbaynms
https://sketchfab.com/thunderbaynms
https://sketchfab.com/thunderbaynms
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Sanctuary’s collections of historic shipwreck models and artifacts. We recommend creating a 
NOAA Ocean Exploration SketchFab account where all models from program activities will be 
housed including photomodels routinely generated during Marine Archaeology NOFO projects 
with credit and link to the oceanexplorer.noaa.gov project landing page. Models are equally 
public-facing products as tools for scientific analysis and documentation. It’s critical for NOAA 
Ocean Exploration to be able to self-host models on SketchFab and a discussion with the 
Department of Commerce should be had to discuss SketchFab’s terms of service. Emily Crum 
should be included and help lead this conversation. 

Conversations with the IT Help Desk should also be had to ensure Agisoft Metashape 
Professional, Free File Sync, Synology DSM (the dashboard software to access the NAS), and 
Adobe Photoshop are approved software packages and able to be installed on the pending 
computer upgrade for the NOAA Ocean Exploration marine archaeologist (Phil Hartmeyer). 

Appendices 

Appendix A: ROV Dive Planning for Photogrammetry Data 
Collection 

 Establish a priority list for the dive based operations, taking into consideration community input 
and the capabilities of the EX/ROVs. What is priority and secondary? For example: Collecting 
data for a photo-model is priority and artifact documentation is secondary. 

 Develop a plan(s) of action with the GFOE pilot team in advance of the dive. Recommend having 
at least two contingency plans in place. Provide GFOE pilot team with builders’ plans of UCH site 
if available, historical documents to include context of sinking event, and 3D CAD models of the 
UCH site if available. This will help the pilots visualize the site before the dive. 

 Discuss potential hazards on site such as current, visibility, snagging hazards (fishing nets, lines, 
etc.), overhead environments, and/or hazardous cultural material (oil, unexploded ordnance, 
etc). 

 Based on the above information, plan the flight path of the ROV for photogrammetry. For the 
best possible model, it is recommended that multiple passes be made. 

 The first pass should include as much of the UCH site as possible to include where it 
meets on the seafloor, maintaining a distance of 5-10 meters for 360 degrees around 
the site. The speed of the ROV is dependent on the pilot's comfort to operate the 
vehicle safely on the site. It doesn’t need to be a slow crawl, but should not be as fast as 
possible. 

 A second pass should begin at the same location as the first, but farther up on the site, 
possibly at the furthest extent of the site. The camera can be tilted down to capture the 
top of the site if necessary. The same speed and distance for the first pass apply here as 
well. 

https://sketchfab.com/thunderbaynms
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 If hazards are accounted for, additional passes can be made of the site from a plan view 
(top down) perspective following a longitudinal transect path of the site. This should be 
started from where the second pass ended and go from right to left or left to right. 
A similar path can be taken that goes laterally across the site. 
An auxiliary pass can be taken of a section(s) or an object(s) within the site. To do this a 

360 degree rotation around these sections is needed. 
(NOTE: These are recommendations and these sequences can be modified to suit the 
particular dive. For example if only one pass can be made and auxiliary passes, adjust as 
needed. Additionally, proceed with this guideline as the dive time permits and 
environmental constraints will allow). 

 If possible, plan ship-moves prior to dive to ensure optimal coverage of the site for 
photogrammetric purposes. 

 Lighting for photogrammetry purposes should avoid casting shadows. The brightest lights aren’t 
necessary, but a consistently lit shot devoid of shadows is ideal. 
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